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DataWeb Device

The DataWeb 4000 series brings a flexible new approach to remote asset monitoring and data acquisition, combining advanced communication methods and accurate measurement into a highly affordable package requiring minimum set up.  The DataWeb unit is DIN rail mounted unit providing eight analog channels (supporting voltage, current and thermocouple sensors) and eight digital channels in a rugged and compact unit.
Installing DataWeb

DataWeb can be installed on a partition formatted to NTFS, or a standard FAT partition.  

It is essential you log on with Administrator privileges before installing DataWeb.
Click on the Start and then Run 

Enter the path to Disk1 of the DataWeb setup folder
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Follow the Install Wizard screens. In most instances it is recommended to use the default answers to questions as follows:
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Accept the default directory location or use the Browse button to select your preferred directory location and name. 
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You must read and accept the end user licence agreement before the installation can continue.  Using your mouse scroll to the bottom of the licence dialog.  When you reach the bottom of the licence dialog, the “I Agree” button will become active.  If you have fully read and agree with the end user licence agreement (EULA), click the “I Agree” button to continue with the installation.  If you do not agree with the EULA click the “I Disagree” button to terminate the installation.

Select the Program group where you want the program icons to be stored.
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Enter the Device number under which the DataWeb will be installed.
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Enter prefix information.
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If mail servers or Datawebs are to be accessed over modem connections on Windows 2000, ensure the Service is configured to log on as a user with access to the modem connections.

Installation is now complete, once the machine restarts you are ready to start the software.

DataWeb Configuration Menu

The first time Orchestrator is configured it is necessary to enable and configure the way you wish the overall DataWeb Device to operate.   To configure the DataWeb System either select Devices from the menu bar on the Orchestrator Window and then DataWeb or double click the DataWeb Icon in the Orchestrator Program Group.
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The DataWeb Device Configuration window will appear:
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To configure the operation of the whole DataWeb Device choose the Advanced Configuration button.

Saving DataWeb Configurations

When all the necessary DataWeb Modules and channels have been configured, or after any changes have been made to an existing configuration, return to the DataWeb Device Configuration Window to save the changes to the current configuration settings stored on the computer’s hard disk.

The configuration must be saved to retain any changes made.  

To save:


Click on the Save icon[image: image10.bmp]. The DataWeb configuration will be saved to the current Orchestrator System configuration.  No File Name will be requested, but the configurations will be saved to the default configurations files stored on the hard disk.

or

Select Save from the File menu.

or

Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.


1.1. Import DataWeb Configurations

Select Import Configuration from the File Menu to import channel configuration from an ASCII file.   This command presents an Import dialog box, where you may specify the range of channels to be imported, the file to import from etc.

1.2. Export DataWeb Configurations

Select Export Configuration from the File Menu to export channel configuration to an ASCII file.   This command presents an Export dialog box, where you may specify the range of channels to be exported, the file to export to etc.

Import/Export Dialog
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The Import/Export dialog allows the user to configure how channel configurations will be imported/exported. User settings are saved and are used as default settings the next time the dialog is invoked.


Header

If Header is checked column headers will be exported with the configuration, these headers make it easier to identify the contents of each column
Value Width

Results are stored in the Systems Log Files with full floating point precision.  The actual width of the number passed can be modified.  In the Value Width text box enter or edit the total number of digits, including the decimal point required.  If the value when converted is greater than the width defined the value will be converted to Scientific notation.

Value Precision

In this box enter the number of digits after the decimal point.

Delimiter

Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the spreadsheet package to import the data correctly.  The choices are:



User



Space


 
Comma  



Tab.  

Most modern spreadsheets including Microsoft Excel and Lotus use the Comma separator.

As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.

End Line

Similar to the Delimiter there are choices for the end of line separator.  The choices are: 



User



CR/LF.



LF (Line Feed) 



CR (Carriage Return) 

A User option is again an option.  Microsoft Excel and Lotus require CR/LF end of line characters.

Import/Export File

Enter the path of the file you wish to export to or import from. Alternatively click the button on the right hand side to browse for the desired file.

Channel Range

Select the All Channels button if you wish to import/export every channel configuration.

Alternatively select the Channels button and enter a range of channel configurations you wish to export.

Interrogate Dataweb Modules

The user can interrogate the LAN to determine what DataWeb modules are present on the Network and read their configuration into the next available slot.

This can be achieved by clicking on the Network Modules button on the Edit menu or the Network Modules button on the toolbar. The user will be presented with the following dialog:

The left hand column contains a list of all DataWeb modules that have been found on the LAN.  The right hand column contains a list of all DataWeb modules that have been configured.  

Click read configuration to read active modules on network which are configured as inactive.

The Network Modules button will not find any DataWeb modules on the network if you are running a firewall.  You can check if Windows XP Internet Connection Firewall (ICF) is enabled on your LAN Connection by launching the Control Panel and selecting Network Connections.  Right click on your LAN connection and select Properties.  Click the Advanced tab, in order for Network Modules to function correctly the Advanced tab should be configured as below:
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Advanced DataWeb Configuration

The Advanced DataWeb Configuration Window appears as shown.
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To ensure that the DataWebGlossDatascan.52 Modules are included in the Orchestrator system check the 

Auto-Enable Device box.

DataWeb Scan Rate

Here you can set the Rate at which the DataWeb driver will acquire data from the local DataWeb Module(s). or the rate the local DataWeb driver will check to connect to remote DataWeb or mail server.

Save Outputs.

To enable this utility check the Save Outputs flag. All values in output channels are saved to disk when the system is disabled. The next time the system is restarted the values which were previously in output channels will be restored to the appropriate channel number.

At startup if Save Outputs is set digital outputs are written to DataWeb.

At startup is Save Outputs is unchecked digital outputs are read from DataWeb.

Check Email From DataWeb(s)

DataWeb has the ability to check a mail server for email that have originated from the DataWeb device(s).

Align Time – This is the time to which the mail server poll will be aligned to.  Enter the date and the time in 24 hour format in the ALIGN TIME text box:

YY / MM / DD

HH : MM

** / ** / **

** : **

If no change is made to the text box, and asterisks (*) are left in all the fields, then the align time will be when the system is enabled.

If a time is entered, but no date specified then a mail server poll will commence the next time the prescribed time is reached after the system has been enabled.  

Entering a date sometime in the future will have the same effect as that described for time.  

An align time of a date in the past is also acceptable. Again this will allow mail server polling to start when the system is next enabled.

Check Email Every – The driver will poll the mail server at the selected interval.

Remote – If remote is selected the driver will attempt to establish a Dial-up connection to poll the remote mail server. If running on Windows XP the connection must have been established for All Users. If running on Windows 2000 the service must be configured to log on as a user with access to the network connection.

The connection name can be set to LAN CONNECTION to test remote operation (e.g. scheduling etc.) over a local area connection.

POP3 Mail Server Name/IP Address – The name of the mail server or its IP address which the driver will poll for email which have originated from the DataWeb Device(s).

Port – The Port on the mail server on which to poll for email.  Generally Port 110 is used for POP3 but you may need to check this with your Network Administrator or you ISP.

Username – The POP3 username which is required to log on to the mail server.

Password – The POP3 password which is required to log on to the mail server.

The Pop3 account should be the account used to access the mailbox of the Email Address configured on the Email Setup of Dataweb.

Check Email Command Digital Channel – When the digital channel is set High the mail server is polled for new email.

Email Check Active Digital Channel – The digital channel is set High when the server is being polled.  This will override any scheduled mail server polls.

Email Check Count Analog Channel – Each time the mail server is polled this count is incremented

Email Check Date Analog Channel – Each time the mail server is polled the date of the poll is stored in this analog channel as an YYMMDD value.

Email Check Time Analog Channel – Each time the mail server is polled the time of the poll is stored in this analog channel as a HHMMSS value.

Configure DataWeb Module

On an unconfigured system the DataWeb device configuration window will show all ranges inactive.
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To configure a DataWeb Module point to the appropriate channel block in the DataWeb Device configuration window and double click.

A Configure DataWeb Module dialog will be shown.
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Module Type 

From the Module Type drop down list select the DataWeb Module type to be configured.  The module type number is prominent on the front of each DataWeb Unit.

Address

Enter this IP Address of the DataWeb Module.  If you are using a local Dataweb use the IP address specified on the network screen of the Dataweb configuration
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If you are using a remote DataWeb use IP address specified in the Dial-In Local IP field of the Modem page on the Dataweb configuration

[image: image17.png]2 Configure DataWeb 4000 - Microsoft Internet Explorer i [=] - |

oder =
Dislwp Baudrate S0

Disi-in Rings 2

Disl-in Local TF 25.0.0.1

Disl-in Remote Tp (p0)  23.0.0.2

Disl-in User dstaved

Disi-in Passwora astaven

Disl-out Tel. o ssiea1iz1121

Dis-out User (15F) usernane

Disl-out Password (Is?)  password

fomwod | Aefesh





Remote Settings

When remote is checked the system will attempt to use a Windows Dial-Up connection to establish an Internet Connection which can be used to connect to the remote DataWeb Device.  Use the Settings button to configure how and when remote connections will be established.

Configure Channel

This button will bring up a dialog with the configuration of the selected channel.

Browse Module

This button will launch Internet Explorer and will connect to the DataWeb Device.

Write Configuration

This button will write the configuration to the DataWeb device.

Remote Settings
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Network Connection is the Windows Dial-up connection.  If running on Windows XP the connection must have been established for All Users. If running on Windows 2000 the service must be configured to log on as a user with access to the network connection.
The connection name can be set to LAN CONNECTION to test remote operation (e.g. scheduling etc.) over a local area connection.

Schedule Scanning

Align Time – This is the time to which scheduled DataWeb queries will be aligned to.  Enter the date and the time in 24 hour format in the ALIGN TIME text box:

YY / MM / DD

HH : MM

** / ** / **

** : **

If no change is made to the text box, and asterisks (* ) are left in all the fields, then the align time will be when the system is enabled.

If a time is entered, but no date specified then a DataWeb query will commence the next time the prescribed time is reached after the system has been enabled.  

Entering a date sometime in the future will have the same effect as that described for time.  

An align time of a date in the past is also acceptable. Again this will allow DataWeb querying to start when the system is next enabled.

Scan Every – This specifies how often the DataWeb Device will be queried.  In the drop down list there a number of pre-defined scanning intervals.  There is also an option for the user to create a scanning interval by selecting the Time option.

Read Files from DataWeb on Initial Scan

Read General & Event Logs from the DataWeb so that users can view historical data. 

Directory – The directory where log files will be stored. The Dataweb csv files are stored in this directory along with the converted data log files. An EVENTS subdirectory is automatically created for event log files.

Delete Files on DataWeb after Upload – Old log files can be removed from the DataWeb when a new log file is read from Dataweb.

Append Log Files – This option allows new log files to be appended to the end of existing data log files.

Check for Receipt of Alarm/Alert Email

Dataweb Email Address – This setting should be obtained from the Email settings tab on the DataWeb Device.  This is the email address emails are sent from.  In the example below email will be sent from the dataweb@orange.net email address.

Alarm/Alert Message – This setting should be obtained from the Email settings tab on the DataWeb Device.  In the example below both the Alarm & Alert messages are configured as “Dataweb Message”

Store Emails in Directory – Directory where emails will be stored

Perform Scan/Upload on Receipt of Alarm/Alert Email – When checked the DataWeb Driver will scan values & upload files to the DataWeb Device each time an email arrives from the DataWeb device.
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Command and Feedback User Channels

Scan Command Digital Channel is used to start scanning when set high and to stop scanning when set low.

Scan Active Digital Channel is a feedback channel which is high when connection has been established and low when it has been terminated.

Scan Count Analog Channel starts at 0 when system enabled and increments on each scan.

Scan Date Analog Channel appears in an analog channel as YYMMDD

Scan Time Analog Channel appears in a digital channel as HHMMSS

Controlling DataWeb

Reconfigure

When configuring channels, the configurations are stored on the hard disk. However, they are not used by the overall system until the Reconfigure option is selected. When Reconfigure is selected, all configurations are reloaded from disk into the system.

Reconfiguration is only possible if the device is enabled.

Initialise

During configuration, a channel can be designated as being a referenced channel. When Initialise is selected, a reading is taken on these referenced channels. Thereafter these readings are used as the "zero" readings i.e. at each scan the “zero” readings are subtracted from the input values to give "true" values. This is useful for example in a strain gauge input where the reading would be non zero under no strain.

Initialise is only possible when the device is enabled

Reset

Choosing Reset from the Control menu will reset all digital counters to zero.

Enable

To enable DataWeb, that is to start the interchange of information between the physical devices and the system choose Enable from the Control menu.

Disable 

To disable DataWeb, that is to stop the system from polling the DataWeb device for information, choose Disable from the control menu.

 Analogue Input Channels.

From the Configure DataWeb Module window point and double click on the channel to be configured.
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Enable Channel 

The Enable Channel check box must be checked to enable, and allow this channel to be configured and ultimately included with all other configured channels in the overall Orchestrator system.

Tag 

The tag is a 15 character alphanumeric field that can contain channel information or wiring schedule references.

Description 

The Description field is a 32 character alphanumeric field in which a description of the channel can be detailed. 

Engineering Units

Minimum

The Minimum default scale value used in displays.

Maximum

The Maximum default scale value used in displays.

Descriptor 

An 8character field available to describe the units of the measurement.

Scaling

Some transducers give a voltage of 4-20 mA output proportional to their full scale range. E.g. A pH transducer may give an output of 0 - 1000mV representing a pH measurement range of 0.2 to 0.8 pH. The scaling feature allows the user to convert easily to Engineering units, pH in this example.

To enable the utility check the Scaling Check box. The Slope and Offset values can be entered directly into the text boxes.  The formula applied is:





y = mx + c       where:
m is SLOPE





x is the measured value.





c is the OFFSET  

Auto Scale 

Click on the Auto Scale button if you want the scale and offset values calculated automatically.  In the dialog box enter the values in the text boxes.  The low measured value, and the high measured value, the output range of the transducer. In the dialog box shown, enter the values in the text boxes; the low measured value, the high measured value and the output range of the transducer. In the above example the measured values would be 0 and 1000. In the engineering value boxes enter the range of the actual engineering units, e.g. 0.2 and 0.8
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When the fields have been completed, and assuming the Orchestrator system is enabled, click on Apply button. Under the heading Current Values the measured value will be shown as well as the new converted Engineering Value.

Click on OK to accept the scaling, or Cancel to abort the Auto Scaling feature.

NB.

Scaling will not be applied to the channel, even if the system is enabled, until the system is next enabled or the DataWeb Device is reconfigured.

Significant Change

To enable the Significant Change feature check the Sig Change check box.  This facility allows filtering of data on channels on which significant change is of interest.  Such changes can cause an event, which can be logged.

The figure entered in the Value text box, in engineering units, is the rate of change that if the measured channel exceeds per scan, either increasing or decreasing will cause the significant change event trigger.    The scan rate is determined in the Advanced DataWeb Device Window accessed from the DataWeb Device Configuration Window, 

If a logger is configured in Event mode, or Period-Event, each time the significant change trigger operates information on the channels defined in the logger will be recorded.  A significant change event only lasts one scan, unless the next reading also changes greater than the Significant change value.

When monitoring channels, if the Significant Change is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.  

For example:
In a test concerning a chemical reaction, a channel is monitoring a temperature. The temperature changes very little for a long period of time, then when the chemical reaction occurs, rises rapidly to a peak, then falls rapidly back to a quiescent state.

If the scan rate in the DataWeb Configuration section is set to 1 scan per second and the Value entered in the Value text box is 2.0 the measured value will trigger the significant change when the temperature from one scan to the next changes by an amount exceeding 2.0 degrees. If the change between scans is less than 2.0 the significant change will not be triggered.

The significant change events are in addition to those caused by an Event.

Event Checking

Event checking is used, if required to trigger a logger to record information on a number of channels during an event. Check the Event Checking check box if this facility is needed.

High Limit  

A value, in engineering units, entered in this text box will define the level that, if exceeded, will cause an event trigger.

Low Limit 

A value entered in this text box will define the level that if the channel result falls below will cause an event trigger.

Alarm Error Checking

Drive Common

A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.

Check this box if a link to the Common Alarm is required.

Priority

Enter or edit the number in the text box to allocate the priority of this channels alarm.

Delay


Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.

Calibration Constants

The following list shows the configuration parameters that must be applied to the various sensor types in order to ensure the values shown are in the correct range and engineering units. 

	Process Options
	Configuration Parameters
	Units

	Direct 
	No Parameters


	Volts

	Linear
	Y = A + B.t
A=offset B= Scale


	User Defined

	Thermocouple
	A = Temp Offset
	Deg °C

	2 Wire RTD
	A = Excit. Voltage 
B = Resistor/RTD ratio
C = Lead Resistance 
	Deg °C

	3 Wire RTD
	A = Excit. Voltage 
B = Resistor/RTD ratio
	Deg °C

	RTD
	A= V Excitation
B = Ratio(Sense Resistor/ PT 100 Resistance) @ 0 Deg C
C = Lead Resistance
	Deg °C

	Thermistor (CJC)
	A = Excitation Voltage
B = Sense Resistor value (Typically 1 K Ohm)
C = Sensor Resistance at T0 
D = Temperature T0
E = Beta Value (typical 3898)
F= Offset (Correction Factor)
	Deg °C
Typically R0 and T0 are the 
resistance of the sensor at 25 Deg C

	Current Scaled
	A = Sense Resistor
B = low Input ( typically 0 or 0.004) 
C = High Input *( typically 0.02)
D = Engineering output for Low in level
E = Engineering output for High in level
	Engineering Units
A = 0 for 0 mA input or 0.004 for 4 mA
B = 0.020 for 20 mA input
C = Engineering output for 0 or 4 mA
D = Engineering output for 20 mA input

	Threshold
	A = Threshold Voltage
	% Time/minute

	Valve Position
	A = Sense resistors 
B = low current setting - 0 or 4 mA
C = High Current Setting - 20 mA
D =Offset 
E = Gain 
	% open 
Range 0-100 

	Scaled Voltage 
	Voltage input scaled output in engineering units

Use Current Scaled option with the following options
A = Sense Resistance = 1
B = Low Voltage input
C = High Voltage input
D = Engineering Units output for Low input setting
E = Engineering Units output for High input setting
	Engineering Units


Example of 4-20 mA input signal representing -50 to 200 Barr pressure with a 100 Ohm Sense resistor will require. 
A = 100 (sense resistor) 
B = 0.004, 
C = 0.02, 
D = -50 
E= 200. 

Example of an inclinometer sensor output with null level (0 deg) @ 6V and 60mV/Deg output configured to show 0 to 2 degree movement.

Use Scaled Current process option

A = 1
B = 6.000 (output at 0 Deg)
C = 6.120 (output at 2 Deg)
D = 0 (Represents 0 level - null position)
E = 2

The DataWeb will display a result between 0 - 2 for input signals between 6.000 and 6.120V

Low and High Alarm Checking

Alarm checking is available on all channels throughout the Orchestrator system.  Low Alarm and High Alarm levels can be configured independent of each other. All the values entered are in engineering units.  If a channel reading exceeds the High Alarm limit then an alarm will be triggered as it will if the channel goes below the Low Alarm limit.  

When monitoring channels, if the high or low alarm is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.   

To configure the Alarm checking section of the ‘Configure DataWeb Channel Window’ complete the options as follows for either or both the High Alarm and Low Alarm checking.

Enable Alarm Checking 

Check either the Low Alarm Checking or High Alarm Checking or both check boxes to enable the facility.

Alarm Limit 

The value at which the channel will flag an alarm.

Warning and Limit (Analogue channels only) 

If required, a warning can be displayed when a channel reaches a limit close to the alarm limit. For low alarm checking, the alarm limit must be less than the warning limit. For high alarm checking, the warning limit must be less than the alarm limit.

Delay 

Specify the number of seconds the channel must be in the alarm zone before an alarm will be flagged within the system.

Hysteresis

Hysteresis can prevent 'noisy' channels from reporting multiple alarms or warnings when the average reading is close to the alarm or warning threshold. The Hysteresis value is relative to the warning or alarm limit.
For example, if a channel’s high alarm is set to 80 degrees C, Hysteresis is enabled and a Hysteresis value of 5 degrees C is specified the system will respond as follows 

When the channel reading goes above the high alarm limit of 80 it will trigger the alarm. The alarm will not be reset until the channel reading falls below 75, the high limit - Hysteresis value.

Check the box if this feature is needed.  Enter the value of the dead band in the text box.
Priority 

Enter or edit the number in the text box to allocate the priority of this alarm.  
Drive Common Alarm 

A common alarm is a single digital output, which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.

Check this box if a link to the Common Alarm is required.

Alarm Message 

An Alarm Message can be defined to be displayed on the Status line of the Orchestrator Main Window when a channel goes into an alarm state. 

Enter the message, up to 32 characters.

Window Buttons

Seven buttons are at the bottom of the Configure Analogue Input Channel Window.  Their use is explained below.

[image: image22.bmp]
When a channel has been successfully configured click on the OK button to accept and move back to the previous window.

[image: image23.bmp]
Clicking on the Cancel button will nullify any changes made.  The configuration of that channel will remain unaltered. The previous window will be displayed.

[image: image24.bmp]
If the configuration of the current channel is to be repeated, clicking on this button will copy the configuration to the Windows Clipboard.

[image: image25.bmp]
When a configuration has been copied to the Clipboard it can be pasted into any other channel on this DataWeb Module by this button.
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Clicking on Previous or Next buttons will accept the current channels configuration and move on to either the next or the previous channels Configuration Window. 

[image: image27.bmp]
If any Help is required concerning any element of this window, clicking on this button will select the Help utility.

Digital Input & Output Channels.
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From the Configure DataWeb Module Window, point and double click on the channel to be configured.

Enable Channel 

The Enable Channel check box must be checked to enable, and allow this channel to be configured and ultimately included with all other configured channels in the overall Orchestrator system.

The first section of the configuration consists of entering details about the channel 

Tag 

The Tag field is a 12 character alphanumeric field that can contain channel information or wiring schedule references.

Description 

The Description field is a 32 character alphanumeric field in which a description of the channel can be detailed. 

Low State Description

A 32 character field in which to enter a description of the low state of the channel.

High State Description

A 32 character field in which to enter a description of the high state of the channel.

Event Checking


Event Checking is used, if required, to trigger a logger to record information on an event. If this facility is required click on the drop down list box and select DISABLED, HIGH STATE OR LOW STATE as appropriate.

Alarm Error Checking

Drive Common

A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.

Check this box if a link to the Common Alarm is required.

Priority

Enter or edit the number in the text box to allocate the priority of this channels alarm.

Delay


Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.

Alarms

Alarm State 

Alarm checking is available on all channels throughout the Orchestrator system. To configure alarm checking on this channel click on the drop down box and select OFF, HIGH STATE, or LOW STATE as appropriate. If a channel's status changes to an Alarm State an alarm will be triggered on that channel. When monitoring channels, if the alarm is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.   

Alarm Priority 

Enter the priority of the alarm triggered by this channel.

Common Alarm 

Channels can be configured to trigger a Common Alarm.  A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.

Alarm Delay 

Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.

Alarm Message 

An Alarm Message can be defined for displaying on the Status line of the Orchestrator Main Window when a channel goes into an alarm state.

Window Buttons

Seven buttons are at the bottom of the Configure Digital Input Channel Window.  Their use is explained below.
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When a channel has been successfully configured click on the OK button to accept and move back to the previous window.

[image: image30.bmp]
Clicking on the Cancel button will nullify any changes made.  The configuration of that channel will remain unaltered. The previous window will be displayed.

[image: image31.bmp]
If the configuration of the current channel is to be repeated, clicking on this button will copy the configuration to the Windows Clipboard.

[image: image32.bmp]
When a configuration has been copied to the Clipboard it can be pasted into any other channel on this DataWeb Module by this button.
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Clicking on Previous or Next buttons will accept the current channels configuration and move on to either the next or the previous channels Configuration Window. 

[image: image34.bmp]
If any Help is required concerning any element of this window, clicking on this button will select the Help utility.

2. Notes & Examples

2.1. Remote Connections

If Save Outputs on a remote DataWeb are set the remote DataWeb will be scanned and outputs set when the system is enabled or reconfigured.  If Digital Outputs on a remote DataWeb are changed a scan and outputs set is initiated.

If a remote connection is already made in Windows (I.e. a Dial-up connection is already established) the DataWeb Driver will not attempt to initiate another connection.

2.2. Time Synchronisation

On the first connection to a local DataWeb the DataWeb’s time is synchronised to the host time.  On a remote connection after files have been uploaded DataWeb’s time is synchronised to the host time. 

2.3. Using Configurable Monitor with Remote DataWeb’s

The example below demonstrates how to establish a connection to a DataWeb device from Configurable monitor, and terminate the connection when finished.

Each button represents a connection to a different DataWeb.
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Each button is configured similar to the configuration below.  From the Navigation Settings select Run Command Line and Monitor.  This will establish the connection and open the appropriate monitor.

In the Run Command Settings enter the Command Line in the following format:

Rasdial <Connection Name> <username> <password>

· RasDial is a Windows Command line function which allows the launching of Windows Dial-up connections.  

· <Connection Name> is the name of the Windows Dial-up connection you want to use.  If you have multiple DataWeb’s you will need a separate Dial-up connection for each as each DataWeb will have a different phone number.  You must already have configured a Dial-Up connection in Windows.

· <username> The User Name you wish to use to connect to the DataWeb.  The username is defined on the Modem Configuration screen of the DataWeb device as shown in below.
· <password> The Password for the specified Username.  The password is defined on the Modem Configuration screen of the DataWeb device as shown below.
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When the user clicks the button the monitor will attempt to establish the specified Dial-up connection, the DataWeb will authenticate the Username and Password.  The appropriate Configurable Monitor screen will then be launched and the values on the screen will update after the initialise.
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To hang up the connection and return to the main screen, a navigation button with properties similar to those below is required.  The RasDial command is configured to hang up the connection.
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